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Introduction
Patient’s Medical Home

When an EMR is used in a meaningful way within the Patient’s Medical Home (PHM) model it supports
effective patient panel identification, panel maintenance, panel management and will enable proactive
panel-based care for patients in a practice.
Meaningful use of the EMR for ‘Panel & Continuity’ involves knowing which patients are actively attached
to each provider and using this information for scheduling purposes and to monitor supply, demand and
continuity with the provider. This work is foundational for success, and must be discussed with the entire
practice, arriving at agreed upon policies and procedures on what, why and how data is to be captured
and maintained with the EMR.
‘Organized Evidence Based Care’ for preventive screening is a logical place to start to learn how to use the
EMR for panel management, or in other words, proactive panel-based care. Once EMR processes have
been successfully implemented for preventive screening, they can be adapted for disease management
and care of patients with complex health needs. Finally, ‘Care Coordination’ processes will leverage those
developed for panel, continuity and organized evidence based care.
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Foundation for Success - Commitment to
Standardization in the EMR
Successful standardization of data entry for improvement or change, apart from leveraging the inherent
functionality of the EMR, relies heavily on three “people and process” principles in conjunction with the
use EMR functionality.
These are:
1. Team


Includes having ‘engaged leadership’ and inclusive team representation within each clinic or
organization; a clinic champion for EMR standardization can be named



EMR improvements or changes do not happen in isolation, and require commitment of time and
resources for improvement to happen



Combining EMR improvement with enhanced use of team, process improvement with a clinical
goal in mind and practice facilitation is the ideal strategy in working toward adoption of the PMH



Leverage PCN supports where
Managers/Coordinators, etc.)



Team sets aside time to meet to agree on processes that enable proactive panel-based care and
documents them to keep everyone on the same page (e.g., job aid and/or standard operating
procedure manual)

they

exist

(i.e.

Improvement

Facilitators,

Panel

2. Data Quality




Data Standardization – for the main areas of data input, the entire clinic team should discuss and
agree upon:
o

use of fields in a standardized way, create structured exam forms or templates for the
consistent capture of patient information; if the team wants to find it later or be able to
search a population for the information, it helps to know where it was entered and if the
EMR search/query tool can search it

o

utilizing standardized text or macros (common repeated text) whenever possible instead
of free text

o

verification processes to ensure over time that data recording is reliable (e.g., BP is
always in the BP field and not in a text box)

o

job aids for staff to assist with consistent patient data chart entry (e.g.,. scanning and
attaching documents to patient charts)

o

processes to record patient problems with the appropriate ICD9 identifier (highly
recommended) Sample Problem List: Appendix B

Roles and responsibilities for charting (e.g., does the person who rooms the patient always chart
BP, height and weight). When making changes to information outside of chart notes (e.g.to
patient demographics or when making bulk /batch changes) it is recommended that the
individual making the change enter their initials in an appropriate area.
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It is advised that one person or a small group provide direction for patient data entry to ensure
high quality in the clinic and minimize data inconsistency. Creating ‘Good in, Good out’ processes
at the practice



Documentation of Standard Operating Procedures (Policies, Procedures and Processes) assists a
clinic team in having a common understanding of workflow; these should be reviewed
periodically



Communicate with the practice team the linkage between data entry and the ability for a pointof-care reminder (e.g. Notifications , Rules, Alerts, etc.) to function and inform reporting

3. Incremental Change


A key recommendation is to take baby steps in EMR changes, especially when it concerns
practice-wide point-of-care reminders. These can be managed to make the changes small and
sustainable for the practice team



Use the simple but effective ‘Model for Improvement’ method including applying plan-do-studyact (PDSA) cycles to identify and test small incremental changes toward the desired and clearly
identified improvement goal



When a new point-of-care reminder is put in place an associated, documented ‘people process’
needs to be developed and implemented; thus making the change effective and sustainable, by
embedding it into the work process and clinic culture

Help Files
Along with this EMR Guide and Videos made available on the TOP website, the embedded EMR Help Files
from the TELUS can be a great untapped resource with detailed instructions on how to optimize EMR
functionality.

Help files and videos are searchable within the Wolf help files. Click Search and type the words to search
for in the window.
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Telus Wolf Recommended help files will be referred to throughout this tip document as these are
available to all users.
Additional learning opportunities exist with the Telus Health Wolf EMR Community Portal:

All Wolf users have access to the Community Portal from the home screen.
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TOP EMR Videos
Other useful videos are available on the TOP website EMR resources Wolf tab.
http://www.topalbertadoctors.org/tools--resources/emrsupports/#8

These videos are a supplemental resource to this guide and it is recommended that users view the videos
for detailed instructions.

PMH Resources
Patient’s Medical Home
http://www.topalbertadoctors.org/change-concepts/introduction/patientsmedicalhomeinalberta
Patient’s Medical Home Implementation Field Kit
http://www.topalbertadoctors.org/patients-medical-home-implementation-field-kit/
Patient’s Medical Home Assessments:
Readiness
http://www.topalbertadoctors.org/file/pmh-assessment-for-practices--readiness.pdf
Phase 1
http://www.topalbertadoctors.org/file/pmh-assessment-for-practices--phase-1.pdf
Phase 2
http://www.topalbertadoctors.org/file/pmh-assessment-for-practices--phase-2.pdf
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Panel Identification
Patient Panel Definition
A patient panel is a set of patients that have established relationships with a primary provider. There is an
implicit agreement that the identified physician or nurse practitioner and team will provide
comprehensive, longitudinal primary care. Relational continuity, or an ongoing relationship between a
primary provider and a patient, is enabled by a patient identification process.

Panel vs. Caseload
A panel is the set of patients attached to a specific primary provider. A primary provider is a physician or
nurse practitioner mainly responsible for providing comprehensive primary health care longitudinally over
time to a panel of patients.
A case load is a group of patients under the care of a provider for a limited scope of care. A specialist will
have a case load as will some family physicians, general practitioners or nurse practitioners working in the
areas of maternity care, women’s health and other areas. For example, a PCN has a maternity clinic
where family doctors who specialize in obstetrics offer care to low-risk patients during their pregnancy. In
this case each family doctor will have a case load of patients not a panel of patients. In another example,
a pediatrician is a member of a PCN. The pediatrician may have a handful of patients for whom she
provides their comprehensive, primary care but for most of her patients she is a consultant and these
patients have a family doctor to provide primary care. In this case the pediatrician has a small panel and
a large case load of patients.

Panel Resources
Panel Guide
http://www.topalbertadoctors.org/file/guide-to-panel-identification.pdf
Supportive Tools for Every Panel (STEP) Documents
Developed and shared by the Calgary EQuIP (Elevating Quality Improvement in Practice) Team, these
documents outline the activities and outputs for panel identification and panel management screening
for use at both the practice and PCN levels.
STEP Checklist: a summary of the activities and outputs for panel identification and panel management

screening in a checklist format.
STEP Toolkit: the activities and outputs of panel identification and panel management screening with
suggested tools and related links
STEP Workbook: for use at the practice level to guide clinic teams through the activities and provide a
means to record outputs for future reference
STEP Reference Page on the TOP website contains webinars that support the documents.
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Demographics
Basic Demographic Information
In the demographic area of the patient chart the basic information that is needed for patient panel
identification is:
 Full Name

 Address & Phone Numbers

 Date of Birth

 Primary Provider

 Gender

 Confirmation Date

 Alberta Health Care # (PHN)


 Patient Status (Active or Inactive)
 Status Date

Status
In Wolf, the patient status is entered in Patient Maintenance on the Patient Status tab:

Patient Status is a searchable field in the EMR so it is important for panel identification.

10

Configuring Status
In Wolf a system administrator can customize patient statuses for the practice in addition to what is
available in the EMR at ‘Go Live’. This will allow the practice to narrow down various types of active and
inactive patients in patient lists, reports or for setting up Practice Search Rules.
From the Home screen, choose Configuration > View > Patient Data Codes > Patient Status
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1) In the Patient Status Maintenance screen, complete the Description, Status Code (an in-clinic code
you give to the status) and the sort order, which organizes the order they appear in the drop
down menu. The Location code is optional and can be left blank.
2) Click the “Inactive” box if the status is to NOT be included for the physician’s active patient panel.
3) Save (by clicking the floppy disk icon).
4) If creating another status click on the New icon (piece of paper icon), and begin again.
5) Click Exit when done.

To Delete a Status
1) Click on the Status Code
2) From the top menu in Patient Status Maintenance choose File > Delete.
3) You will be asked to confirm
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Examples of Patient Status Used in Primary Care
Status
Active

Status Name
Office Patient
Specialty Service

Temporary
New
Orphaned/unassigned
Emergency Department
Long term care
Lapsed or Dormant

Inactive

Inactive
Deceased
Non-clinic patient / Not
Our Patient
Duplicate or Archive

Additional Information
Active office patient attached to a provider in the practice
This patient may be active in the practice but only for a given service (e.g.,
vasectomy, aesthetic, maternity care, aviation medical, circumcision, IUD).
Some clinics give a status to each type of specialty service.
Applied to a patient seeking walk-in care. These patients are not
considered part of the provider’s panel.
When a practice is still accepting new patients, a patient may not be
confirmed as an office patient until after a first or second appointment.
When a provider leaves a practice resulting in an unassigned panel, these
patients may be identified.
Mainly in rural centres, where a patient record exists for a visit that
occurred in ER of a non-clinic patient.
For a group of patients seen in a long-term care site but not the practice.
Some clinics prefer to use this term for patients that are inactive, with no
clinic visit in a period of time (e.g., 3 years). They will be given this term
during panel clean up or maintenance.
Includes formerly active patients with no clinic visits in a period of time
defined by the practice, (e.g., 3 years.)
Patient is deceased.
When a patient chart is created for lab work received at the practice or for
a patient never seen at the practice (may apply to a new patient that
made an appointment but never visited the practice).
When a patient has accidentally been registered more than once and the
EMR does not have the ability to merge duplicate records the archived
record has this unique status.

Confirmation
Most EMRs have a designated field for patient demographic data confirmation (also commonly called
verification or validation). Marking this field/box indicates that the primary provider attachment, address,
phone, and patient status are confirmed and up to date. The field also applies a date stamp so that all
team members know when it was last done.
Confirmation is a crucial process for patient care. When a critical result arrives at a clinic, it is essential
that the patient’s contact information is up-to-date so that they may be contacted in a timely way.
Calculating the confirmation rate which may also commonly be called verification rate is an important
process check that indicates how often patient data and attachment is verified by the team. The
confirmation rate calculated over a longer period of time, such as year, should be higher for clinics with
established processes than a confirmation rate calculated over a shorter period of time such as three
months. A team may choose to calculate a confirmation rate over an appropriate timeframe that will give
them feedback on their process improvements. See Confirmation/Validation Rate

Process to capture patient attachment and confirmation
Patients are managed in the demographics screen. A clinic must have consistent and standardized data
entry practices with all these fields as it enables reporting of verification rates, provider lists as well as
demonstrating attachment and confirmation. Wolf’s designated field for patient demographic data
13

verification is at the bottom right corner of the demographics screen. Ticking the ‘Patient Data Verified’
box indicates that the address, phone, patient status and Primary Service Provider are up to date. Ticking
the box also applies a date stamp so you can see when it was last done.

See Useful TOP Videos: http://www.topalbertadoctors.org/tools--resources/emrsupports/#8








Assigning Patients to a Primary Provider
Setting Patient Status
Changing List of Patient Statuses
Managing Patient Status
Attachment and Verification in Telus Wolf
Verification Rate in Telus Wolf
Active Patient Verified in Telus Wolf
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Central Patient Attachment Registry (CPAR)
CPAR is a centralized database that captures the attachment of Primary Care Physician or Nurse
Practitioner and their patients. CPAR is a joint project between The Alberta Medical Association, Alberta
Health (AH), and Alberta Health Services (AHS). The registry will enable improved relational and
informational continuity in primary care across Alberta. Participating providers will have their panel lists
submitted through a secure electronic portal to the registry that will look to see if other primary providers
are paneling the same patients. Participating providers will receive ‘conflict reports’ listing names of their
patients who also appear on the confirmed panel lists of other providers. Another report will identify
when a patient on a provider’s confirmed panel has information that does not match the patient client
registry, including if the patient is deceased.
Teams will confirm at the practice that a patient is attached to a provider and record this in the EMR.
What CPAR can do is verify that patients are not attached to other providers. When a patient appears on
a provider’s conflict report, it signifies that the patient has been attached to another provider’s panel
outside the practice and it will need to be addressed with the patient to confirm which provider (of those
they are paneled to) they wish to consider their primary provider.

Five Key Changes in Behaviors at the Practice
1.
2.
3.
4.
5.

At every interaction ask who the patient identifies as their primary provider
Record it in the EMR & Date Stamp it
Maintain & Review the panel List
Utilize the panel list to plan care delivery
Submit the Panel List to CPAR

Visit the CPAR page at: http://www.topalbertadoctors.org/CPAR/

Producing a Provider’s Panel List
During the panel identification process the first step is to produce a list of all active patients attached to a
provider using the report/search functionality of the clinic EMR. It is useful if the panel list includes the
following columns of information:

 Name (first, last)

 Date of birth (or age)

 Last verification date

 Gender

 Last visit date

 PHN (useful for CPAR)

Sorting by the column headers in the panel list in the EMR or a spreadsheet is a quick way to get an
impression of:

 Patients that have never had their attachment  Older patients that may be deceased.
or primary provider confirmed.

 Patients with no visit to the clinic in greater  PHN’s that indicate out of province patient
than 3 years
Last Visit Date may assist to identify active patients:
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Patients with a visit in clinic during an agreed-upon, predetermined period (e.g., last 3
years)

These lists usually create awareness for initial panel clean up. Confirmation of the data produced on the
lists with the primary provider and team will help to determine validity of the information. Further panel
clean-up is assisted by additional searches in the EMR.
TIP: Wolf will produce the list with the EMR practice search functionality but also offers exporting of
the list for further sorting and analysis in Microsoft Excel or Open Office Calc. Choose the ‘Export to
CSV’ option to try this. Basic spreadsheet training is recommended.

Practice Searches - Producing a Physician Patient List in
Wolf:
See TOP Video: Basic
resources/emrsupports/#8

Patient

List

in

Wolf

http://www.topalbertadoctors.org/tools--

These initial searches inform your initial panel information processes. From the Home screen, choose
Practice Search

Once Practice Search opens:
1. Choose Primary MD under Demographics.
2. Click the box beside “Search All Patients” in the upper right.
3. Click the third icon from the left to show search results as a Patient List.

16
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When a list is produced it looks like this:

The columns may be sorted by the headers by clicking on the header.

TIP: Wolf EMR will produce the list with Practice Search but
also offers exporting the list as a csv file for further sorting
and analysis in Microsoft Excel or another spreadsheet. To do
this, select File > Export All to CSV. Basic spreadsheet training
is recommended and be mindful of privacy requirements;
handle and dispose of that data appropriately.

Other Useful TOP Videos: http://www.topalbertadoctors.org/tools--resources/emrsupports/#8


Searchable Areas of Telus Wolf



Guiding Principles of Searches in Telus Wolf



Active Patient Search in Telus Wolf



Panel Clean Up Searches
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Using the Demographic Viewer
In Wolf, instead of producing a list of patients, it is possible to produce a pie chart of results. The
advantage of this is that the results are generated much quicker and there are ways in the menu to sort
by age, gender and smoking habits. If the desire is to simply get a number, this is the fastest way to
achieve those results.

Initial Panel Clean-Up
Searches/reports that assist initial panel clean up include producing a list of active patients attached to a
provider, with the additional search parameters of:
 Last visit date (and no future appointments)

19

This search produces a list of patients assigned for Dr. Adams WITH a visit in the last 3 years.
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This search produces a list of patients attached to Dr. Adams with NO visits in the last 3
years and NO future appointments booked.



Age: Sorting the list of active patients by age is valuable. In viewing the list of active patients from
oldest to youngest or over the age of 90 years, a provider is usually able to indicate if there are
patients on the list who should be marked as deceased
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No visits to the practice (and no future appointments) – producing a list of patients that are
attached to a provider will identify patients that registered but may have never shown up to the
practice. This search may identify patient charts created but the patient was never actually seen
at the practice (e.g. may apply if a new patient made an appointment but never attended or a
chart created for lab work received for a non-clinic patient, etc.)



Appointment Type/Reason – If the practice uses the appointment type or reason when scheduling
visits, searching by this information may produce lists of patients that are not family practice
panel patients such as ‘aviation medical’ or ‘Botox injection’. See Wolf Help files “Appointment
Reason



Billing code - If the clinic offers specialty services to patients that are not members of the
physician’s family practice, they may be identifiable by billing code from the Schedule of Medical
Benefits



o

Ask the physicians if there are any billing codes that they routinely use for patients that
are not members of their family practice panel

o

Long term care patients are billed with an 03.03E billing code

Procedure codes
o



E.g., searching by procedures offered at the practice, but all the patients may not belong
to the practice, such as vasectomy (75.64)

Address or postal code - Sorting of active patients by the address/city or postal code searches can
be valuable in identifying individuals that may not be part of the family practice panel due to their
place of residence; temporary workers to an area may be identified this way
22



Test Patients – each clinic has test patients that were created for training or practice purposes,
for reporting and analysis; they should not be included in the family practice panels. A common
practice for test patients is to use the last name “Test”. Be sure there are no real patients with
the last name Test. Go through all your test patients and give them an Inactive status. This
generally eliminates them all from your searches.
IMPORTANT: The primary provider and/or the practice team need
to review the data from reports to ensure that the correct
information is being pulled into them. Due to unique protocol at a
practice, fields may be used in a specific way and this may impact
the accuracy of reports.

Bulk/Batch Actions
Once a list is produced and sorted, Wolf can apply a bulk change to the entire list or a group within the
list. Making bulk changes makes the process of initial clean-up and ongoing panel maintenance faster and
easier. From the list you produced, Choose Selection > Select All or click the box beside the patient names
that you wish to make a bulk change to. From Selection you can choose what you wish to modify for
these patients. You can add conditions to their Problem List, add all the people to a Follow up List, Update
patient statuses, etc.
TIP: Carefully verify data with the primary provider and/or care team before making a bulk change.

See Useful TOP Videos: http://www.topalbertadoctors.org/tools--resources/emrsupports/#8


Bulk Change to Inactive in Telus Wolf
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Deactivation (Inactivation) is a two-step process:
1. Deactivate
1) Produce a verified list of patients that the clinic wishes to make inactive.
2) Choose Selection > Select All or click the box beside the patient names that you wish to
inactivate.

3) Choose Selection > Deactivate Selected.

2. Change Status to Inactive
4) Choose Selection > Update Patient Status
5) The Change Patient Status for Selected Patients window
appears.
6) Change status to “Inactive Patient”
7) In the Reason box write the person’s initials doing the
inactivating and a reason. Additional notes may be
added in the box below.
8) Select the current date at the Start Date. Click OK

TIP: Making a chart Inactive does not delete the
chart. If a patient presents to your clinic and was
previously made Inactive, simply change their
status back to Active and verify. The chart will be
re-introduced to a provider’s panel.
24

Panel Maintenance
Once an initial clean-up is complete there are several processes that support maintaining a clean
confirmed patient panel list for each primary provider. Those processes include:
1. Ongoing phone/address data, primary provider attachment and status confirmation at patient checkin. Developing and monitoring a process for all front desk staff with expectations for data
confirmation is recommended.
TIP: In the demographics screen, below the ‘Patient Data Verified’ tick box, the last date verified will
appear. When re-verifying a patient who was previously verified, check the box and it will date stamp
todays date, thereby updating verification.



This process can be checked using the Practice Search. Run a search to produce a list of patients
with visits in a given period of time and determine what percentage of patients was confirmed
during that time frame. If you like, you can choose to run this daily, weekly or monthly. Shorter
time frames help you monitor how consistently you are verifying patients. Refer to Confirmation
more detail on how to do calculate this rate using these searches.
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(The above search will give you the numerator for a confirmation search. To get the denominator,
simply remove the Date of Verification filter and run the list again.)


Standard operating procedures should be in place for front desk staff for:
o

Patients no longer part of the clinic

o

Patients not seen in the clinic (e.g., records created for patients where lab work was
received or seen at another facility like the local ER)

o

Patients seen at your clinic but not your family practice patients (e.g., walk-in or
temporary patients)

o

Patients scheduled for a “meet and greet” appointment

2. Conducting searches at regular intervals and applying bulk actions to patients that are no longer
active at the practice. The regularity of the intervals varies by practice. It may be monthly for the first
year and then every six months thereafter. Reports that assist identifying these patients include
searches by:



Last visit date (and no future appointments)
Age
26







No visits to the practice (and no future appointments)
Appointment Type/Reason
Billing code
Address/city or postal code
Last Name is Test (first be sure there are no actual practice patients with the surname Test)

3. Patient outreach. Some practices identify active patients with no visits in the past 3 years (and no
future appointments), prioritizing those overdue for preventive screening care, then reaching out
proactively to determine if they are still members of the practice. The outcomes of the outreach
involve updating the patient demographics, physician attachment and offers of preventive screening
care.
See Practice Searches for more examples of how to build these

Deceased patients
If a clinic is going to engage in outreach screening, managing the status of deceased patients is critical to
ensure that a deceased patient’s name does not appear on a list for outreach. Screening processes apply
to active patients attached to a provider.
In Wolf, change the patient status to deceased. The start date of the status should be the date the patient
is deceased. Add notes including the initials of the person making this change in the record.

Once a patient is marked as deceased, to view their information in Patient Search, select the Include
Inactive check box. There is a setting in the Scheduler you can select to choose whether you can see
Inactive patients in the search bar. It is recommended to keep these charts visible to avoid the creation
of duplicate charts if a patient returns to the clinic after being inactivated.
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Patients with a deceased status are no longer active and will be excluded in Practice Search when the
“Not Deceased” box is checked.

Panel Management
Panel management, also known as population management is a proactive approach to health care.
Population means the panel of patients associated with a provider or care team. Population-based care
(or panel-based care) means that the practice team is concerned with the health of the entire active
population of attached patients at the practice, not just those who come in for visits.1
The Patient’s Medical Home implementation element of ‘Organized Evidence Based Care’ involves
embedding evidence-based guidelines into daily clinical practice where each encounter is designed to
meet the patient’s preventive and chronic illness needs. Setting up population-wide point-of-care
reminders supports these planned interactions and EMR functionality supports appropriate follow-up
care.

Approaches to Panel Management
Opportunistic
When approaching panel management opportunistically, it means catching a patient while they are in the
practice or calling on the phone with a team member, to offer care.

1

Module 20. Facilitating Panel Management. May 2013. Agency for Healthcare Research and Quality, Rockville, MD.
http://www.ahrq.gov/professionals/prevention-chronic-care/improve/system/pfhandbook/mod20.html
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For example, a 52 year old female is in the practice for an appointment to inquire about the
vaccine for shingles. While in the office her blood pressure is taken and she is offered requisitions
for a FIT test, plasma lipid profile, fasting glucose and mammogram because they are all overdue.
Methods to identify patients that are overdue for clinical services may involve:
 Setting up population wide point-of care reminders (Rules), that alert a team member that a
patient is due for a clinical service
 A team member that combs through the charts of patients meeting certain criteria, who have an
appointment, to identify clinical services that are due and marking the chart to indicate this

Outreach
An outreach method to panel management involves identifying confirmed paneled patients overdue for
clinical services that do not have appointments and ‘reaching out’ to offer care. This process involves
using the search/reporting tool in the EMR to produce lists of patients.
For example, a 58 year old male was last in the clinic 2.5 years ago for a knee injury. The panel
manager2 at the practice has run a report that shows this patient is overdue for a plasma lipid
profile, a FIT test and a fasting glucose. The staff member phones the patient and confirms that
he is still a patient of the practice attached to his paneled physician. * As per clinic protocol, the
staff makes an offer that the patient can come by the clinic and just pick up the lab requisition to
get the overdue screening done and the clinic will follow-up as necessary. The patient agrees.
*Note: such protocols vary from practice to practice. It is an important process that must have
provider agreement before implementation.
TIP: It is recommended that a practice initiating outreach complete panel
identification and maintenance processes first then begin with patients that
have been confirmed as attached, active patients. This will prevent the
experience of contacting patients that are deceased or no longer active at the
practice.

Prioritizing Patients for Outreach
For practices that are beginning outreach for the first time, identifying where to start can be a challenge.
Consider using searchable criteria in your EMR that can guide you to reaching out to patients that may
have the most to gain by offers of care. Consider the following criteria:
 Last visit date close to 3 (or more) years ago
 Age (older patients are at higher health risk than younger patients)
 Number of screening maneuvers due, e.g., consider starting with patients over 60 years of age
with no colorectal cancer, diabetes or lipid panel screening due
 Patients with chronic conditions

Panel Manager is a general term used in practice settings. Role titles can vary by PCN. Other titles in use
may be POET (Proactive office encounter assistant), PCC (Patient Care Coordinator), PMA (Panel
management assistant), etc)
2
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Registries (Cohorts)
A disease registry identifying patients with a coded disease condition is the first step in preparing for
panel management of patients of a given condition. The formation of coding of patients with a condition
is called a ‘patient registry’. Ideally, all patients with a condition will have the condition noted in their
‘Problem List’ in a consistent way. For example, Diabetes is always called ‘Diabetes Mellitus’ and will likely
have the ‘250’ ICD-9 code attached to it. It is important that an entire practice agree on terms for the
conditions to create registries. In this example Diabetes is not named with other inconsistent terms such
as ‘Diabetes’, ‘DMII’, ‘DM2’, ‘Diabetes M’, etc. It is also important that the ICD9 code is attached to that
problem. Any free texted conditions in the Problem List run the risk of not being standardized.

TIP: Free typing in the problem list is NOT recommended. Physicians should use the drop-down list
when coding problems. In some cases a “clean-up” of the list may be needed to enable consistent
coding moving forward. You can add problems to the index that do not have an ICD9 Code by creating
a “fake”code. (e.g. You can create “Complex Health Issues” as a problem list option for physicians to
use.) See the video on the TOP website “Complex Health for PaCT in Telus Wolf”

Merging medical problems in your clinic problem list
If your clinic's problem list contains two or more problems with the same meaning (for example, “DM1”
and “Diabetes Type I”), you can merge the problems into one problem. Merging a problem into to
another problem removes the selected problem from all problem lists. Any patients with the merged
problem retains the original problem, but the problem is now associated with the problem it was merged
with.
While the Service Codes used in claims or billing is a very useful search to inform the practice when
forming registries, it is not in itself accurate enough to be used when creating point of care reminders. An
accurate problem list should be the trigger for the point of care reminders. See Problem Lists
See Useful TOP Videos: http://www.topalbertadoctors.org/tools--resources/emrsupports/#8




Lab Code Maintenance & Merging Lab Codes
Using Problem List ICD9 as Favorites in Telus Wolf
Managing Master Problem List in Telus Wolf
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There are useful searches that will support creation of disease registries. By looking in other areas of the
EMR patients without the problem in their ‘Problem List’ can be identified.
Feature of EMR

Billing
Medications
Lab

Example 1
Data that would inform Diabetes
Mellitus Registry
Diagnostic code 250
Currently taking metformin or
insulin
HbA1c over 7 %

Example 2
Data that would inform
Hypertension registry
Diagnostic code 401
Currently taking an
antihypertensive
BP > value specified by clinic MDs

The bulk action feature from reporting area of the EMR is a useful tool when producing a list of verified
patients with a given condition to add it to the patient problem list in bulk.

TIP: To help update your list of Diabetics, you can build a search of all patients on metformin
or insulin, who do not have Diabetes Mellitus (250) in their problem list. Then bulk add
“Diabetes Mellitus” (250) to their problem list. You can do this for many conditions as you
start to develop more registries.
Important Note: Carefully verify data with the primary provider and/or care team before
making a bulk change.

Panel Management: How to Get Started
Once patient panel identification and maintenance processes are in place, it is recommended to begin
proactive panel-based care with the following approach:

Panel Identification & Maintenance
Panel Lists
Patient Confirmation

Preventive Screening Care
Foundational Learning
Simple to Complex
Point-of-Care
Reminders
Reporting

Disease Management
Disease Registries

Patients with
Complex Health

Proactive Panel-based
Automated processes
Care
to support uncommon
More Complex Point- care requirements
of-Care Reminders
With ICD-9 codes in
place identify complex
patients for systematic
care
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Preventive Screening Care









Preventive screening care involves a small number of data elements compared to disease
management
There is benefit to starting with some clean sources of data like electronic lab feeds compared to
information that may be inconsistently charted in the clinic
Clinic team will learn:
1. the importance of and begin standardization of naming protocols for scanned documents
(e.g., mammograms and colonoscopy reports)
2. from this experience about patterns in their data entry and can make correction for
future meaningful use of EMR
3. practice standard operating procedures that enable proactive panel-based care
The searches and population-wide point of care reminders should start simple and can build to
the more complex
Practices can build on:
1. the number of screening maneuvers they are addressing
and/or
2. the population of patients at the practice that point-of-care reminders are set for (e.g.,
gender and age)
Provides a foundational experience for process improvement

Disease Management






Clinic team take lessons learned from less complex preventive screening care processes that can
then be applied to disease management
Involves more complex searches with more data elements than screening
A dependency exists on reliable registries of patients with a given disease
1. Providers will learn the importance of consistent coding in the Problem List of the EMR
Clinic team will build on the benefits of standardized data entry
Building of more complex point-of-care reminders with increased reliability of planned, prioritized
care

Proactive panel-based care of a registry or cohort of patients with a given condition (e.g., Diabetes or
hypertension) and is enabled by key EMR features:
1. Problem lists (See Registries )
2. Rules (See Point_of_Care_Reminders )
3. Patient Tasks (Follow-ups)
4. Billing information (can be less reliable as coding habits can vary substantially by provider)
5. Practice Searches to create the lists

Management of Patients with Complex Health Needs


With a solid foundation in preventive screening care and disease management, patients with
complexities and multiple co-existing conditions will have visits that address many predictable
health issues by using available EMR resources to more efficiently and reliably meet patient’s
important needs
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Tools for Panel Management
For the following areas it is recommended that when a team agrees on the processes that they are
documented as standard operating procedures so that when a staff member leaves and a new staff
member starts there is documentation.
Useful TOP Videos for this section: http://www.topalbertadoctors.org/tools--resources/emrsupports/#8






Linking Documents with Keywords
Changing Document Keyword List
Manual Results in Telus Wolf
Tips in Using Wolf for Panel Identification, Screening and Preventive Care
Proactive Preventive Screening Care Using Rules and Messages

Charting for Team-Based Patient-Centered Care
For a team to provide care that is patient-centric and takes care of the whole patient, a single provider in
the practice can no longer document in an ad hoc manner. The team needs to know where to find
pertinent information and know that the information can inform proactive, panel-based processes (such
as searches or rules) that can act as a safety-net around the individual patient care.
EMR users need to be aware of the search capabilities of their EMR. Where information is entered
matters! In general, fields that can inform a search or report include:
 Drop down lists
 Boxes only designed to record specific information like blood pressure or weight
 Templated fields in an exam template
Even in an area where free text can be entered, if certain information is entered with a consistent term, it
may be searched. Where common repeated text (macros or auto-replace) is used, it may be uniquely
searched.
Chart in a way that the team can help care for the patient:
 Care team members know where to find information
 The patient’s data may be included in population-wide reminders that helps to prevent patients
“falling through the cracks”
 Monitoring and management can be done systematically

Flowsheets
On the right click menu (within the chart) > View Flowsheet is a great way to summarize clinical
information that is recorded in the patient record. For example, once configured by the clinic it can be
utilized to capture some or all the ASaP Maneuvers in the chart. You can also create condition specific
flowsheets to help gather all the information you need for review of a condition without having to search
the various areas of the chart. Additionally, the Flowsheets can be viewed over time, so you can watch for
subtle trends and changes. (Below is a simple Diabetes Flowsheet). Targets can be configured into the
flowsheet to visually alert you if something is overdue or out of range by turning it red. Anything red
therefore needs to be addressed by the provider.
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This is a flowsheet built specifically for ASaP. It gives any provider an excellent overview of all screening
maneuvers without having to click around the chart. Any additional maneuvers can be added.
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Data from all flowsheet are pulled for information already in the Chart, therefore no manual entry is
required. Every flowsheet is printable, so you can print out and give to patient during appointments to
support their knowledge and care.
Recommended Wolf Help files:
 CDM Flowsheets
 CDM Flowsheet Configuration

Scanned Documents
Every clinic receives electronic faxed documents which get linked to individual patient records. The
naming or indexing of these documents as they are attached must enable two processes:
1) When a provider is viewing the patient chart they should easily identify the information and be
able to find it quickly. Wolf has the ability to search for a document name at the individual patient
level. In the patient’s chart under Documents Tab > Search Bar> Type in the test you wish to find.
As in the screen shot below by typing in “Consult Letter”, this will list every consult letter received
on this patient.

2) Wolf’s Practice Search it is possible to produce a list of patients that have a type of linked
document within a period of time (i.e. Greater than two years since last Mammogram received).
These same document names can be used to create a population-wide point-of-care reminder
(Rule) or help to generate outreach lists for patients overdue for a screening maneuver.
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Using Standardized Document Keywords
When selecting which document keyword for a search or a Rule, all the variations of how it has been
entered in the past will be in the drop down list. Standardize keywords that the whole clinic will use and
make sure all current and new staff follow this list carefully!

Key principles for linking scanned documents




Create a list of acceptable document words that can be used at the practice that is agreed upon
by the clinic team (clinicians and team members). See Appendix C for examples
Use the drop-down list in the EMR; avoid free typing.
Non-standardized keywords can cause your Rules to not match properly. If you notice a Rule
notifying you that a screen is due, and it is scanned into the chart within the current interval. You
may only need to correct the document name to fix the problem. You can do this by changing the
document properties in the chart and rename it with the same keyword you used in your Rule
creation. In the Documents Tab> Highlight the document you wish to rename> Select View
Document Properties> In the box that pops up, choose the corrected keyword from the drop
down menu.
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Certain clinical reports need to be distinguished to enable panel management
o Distinguish mammogram results from all diagnostic imaging. Specifically using
“Mammogram” is a hidden keyword that Wolf can recognize automatically and link
directly to Preventive Care Procedures for you.
o Some consult reports need consistent naming. Pay special attention to documents that
affect Rules and searches:
 Colonoscopy reports
 Flex sigmoidoscopy report
 Colposcopy report
 Mammogram
Provide training to staff and place a printed list of acceptable keywords with indexing tips at every
workstation where documents get linked to patient charts
Name based on type of consultation rather than the name of the consultant. The specialist’s
name alone does not help a provider quickly search through the chart for information.
o E.g., If a referral is for gastroenterologist consult, name the letter “Gastroenterology
consult” not “Dr. Black consult” As Wolf has three keywords you can use, “GI Consult” in
keyword #1, then “Dr. Black” in keyword #2.
Only central clinic EMR administrator(s) should be allowed to add, delete or modify the main list.
This list is configurable in Wolf.

Recommended Wolf Help files:
 Using keywords when linking documents
 Managing document keywords
TIP: If you are a new clinic, starting out with a good standardized keyword list is highly recommended.
If you are an established clinic with many years of data and linked documents, it can be daunting to
attempt to clean up your keywords. Create your list with your team and ensure everyone uses this list
faithfully. For previously linked documents, you can choose to rename these documents depending 37
on how much work you are willing to undertake or just start fresh. If you choose to clean up your
keywords, focus on Mammogram and Colonoscopy first, as these will affect your rules and screening
the most. Don’t try to change your whole list if you don’t need to.

Manual Entry of Lab Data
Most EMRs have the ability to manually enter lab data that may be received by fax or completed within
the clinic. Data may be received this way due to the lab originating from a source outside the region. If
this lab data is entered as a “Manual Result” rather than a scanned document, it can usually be trended
and searched. Manual labs completed in clinic such as a random glucose test should be entered in manual
labs. Some clinics use Manual Labs to enter singular results that are from Alberta Netcare that the
provider wants to see in the lab results sections and so that the results can be graphed with other
investigations received electronically.
Scenario 1:
A provider is opening a new practice. After the first appointment and the patient is accepted into the
practice, on the visit for the first comprehensive medical, the provider wants the last three pap results
entered in the patient’s chart. A team member looks up the results and dates from Netcare in the chart
with the manual labs feature careful to note the dates, results and that the source is Alberta Netcare.
Scenario 2:
A patient with diabetes is also under the care of an internal medicine specialist at a diabetes clinic outside
of the area where the primary care practice is. The clinic gets copied on the patient’s lab results ordered
by the other clinic and they are received as a fax. So that the lab values can be trended with the lab
results ordered at the primary care office, the faxed results are entered as manual lab results and appear
in the patient’s lab investigation section of the EMR not just as a document stored in their chart.

Useful Applications of Manual Lab Entry
The manual lab result feature of EMRs offers a clinic flexibility to store results or information in a way that
they can be trended and searched. Some ways in which clinics are using this feature:


Preventive screening care offers are all documented as manual lab results – they are searchable and
assist the clinic team in monitoring offers and measuring screening care. This requires some set-up
and is very effective where the team that does preventive screening care work



Pain Disability Index is a score that is tabulated at the clinic that documents the level of pain a patient
has. For practices that have a chronic pain clinic, manual lab entry allows them to record the score
and trend against medications over time. It can also assist in quality improvement measurement.



A clinic is tabulating frailty scores of their older patients. Recoding the scores in manual labs allows
them to trend these scores over time, determine which patients in the practice have or have not had
a frailty assessment and allows population based measures.

Create a manual lab
With a patient chart or visit note open, on the right-click menu choose New Manual Result. In this
instance a manual Pap smear result can be documented. Be sure to use the investigation date so the
Rules will notify appropriately. Ensure that if the clinic chooses to enter results in this fashion, that the
Rule is modified to look for these.
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TIP: Manually entered investigation results need administrative work to be graphed!!
Users with administrative authority can make manual results “graphable” by converting them to
electronic investigations in the Investigation Maintenance window. Attaching lab code to an
investigation description enables users to make manually-entered results “graphable”, and for the
results to appear in flowsheets, templates, and cardiac risk assessments.

See the TOP Videos for examples:
 Configuring for Scores in Telus Wolf
 Entering and Graphing PDI and Frailty Scores
 Using PDI and Frailty Scores in Practice Search Telus Wolf
 Manual Results in Telus Wolf
 Lab Code Maintenance and Merging Lab Codes

Customizing investigations and investigation types
You can add or edit investigation types, or categories, and specific lab tests and their descriptions. Attach
a lab code to an investigation description. This is very flexible way to capture various results. To configure
Investigation types, (Configuration > View > Patient Data Codes > Investigations).
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Recommended Wolf Help files:
 Entering Lab Results Manually
 Custom Investigations and Investigation Types

Practice Searches – Building Your Own From Scratch
When learning to create searches the following tips will assist in obtaining accurate data:
 Be informed on how data is recorded at the clinic; this will provide direction on which fields to search
 Build the search one parameter at a time
 Validate, as each line of the search is created, that the results are correct before adding another
parameter to the search
 Search for the positive first then search for the negative
o E.g., if you are searching for female patients 50 – 74 y that have not had a mammogram in
the past 2 years first identify all patients that have HAD a mammogram in the past 2 years.
Once you have validated that your search criteria are correct it is easy to search for patients
that have NOT had a mammogram.
 Verify that your results are correct
See the TOP Videos: http://www.topalbertadoctors.org/tools--resources/emrsupports/#8
 Guiding Principles for Searches in Telus Wolf
Recommended Wolf Help Files:



Practice Searches (video series)
Practice Search
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Beneficial Searches for Care Planning
When patients have been documented as having complex health needs (e.g., Problem List includes
“Complex Health” as an active problem, monitoring frequency of care planning as well as follow-up is key.
Most physicians prefer Annual reviews unless otherwise indicated. There are a few ways to utilize the
EMR to monitor and be proactive with patients. Opportunistic and Outreach workflows can be used with
the following searches:


Complex Care Plan Eligible: Patients with complex health needs with no care plan ever recorded
in their chart. To search for eligibility, the problem list must be current as the EMR relies on this
as well as the 03.04J billing fee code to match the Search/ Rule. In the Practice Search>Saved
Searches folder, are three prebuilt Complex Care Plan Eligible Rules. Review all the criteria to
make sure it contains everything needed. Then save as an Active Rule.



Complex Care Plan Renewal: Patients with complex health needs with a least one Complex Care
Plan on file, but no Complex Care plan completed in greater than one year. This search relies on
the 03.04J billing code and can use previously scanned Complex Care Plan documents (If no
billing history).
Note: Remember to assign your Complex Care plan document and any Care Planning
template separate and standardized keywords. If there is variation in how the documents are
named, the Rules/ Searches will not match. If you have previous documents scanned in
without a standardized keyword, you must account for all the existing keywords in use.
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Patients with complex health needs with a care plan but no specific appointment type
designating a care plan follow-up in the last 6 months
o

This search depends on the practice having a unique appointment type designated as a
care plan follow-up. Use caution if using this method. From a workflow perspective,
variation in how the staff book patients can cause problems. (e.g. Patient books a
Complete Physical exam, then completes a Complex Care plan in the same visit. If it is
not booked as a Complex Care plan, it may be missed) If your searches rely on
appointment types there is more chance of conflicts. It may be a more reliable workflow
to rely on the billing codes, (Complex Care Plan 03.04J).

Recommended Wolf Help files for setting up Appointment Types:


Configuring Appointment Reasons

Follow-up
EMRs have features for individual patient follow-up where a task is created to remind a team member to
follow-up with a patient at a specific time for a specific reason. This feature is indispensable for chronic
disease management and care of patients with complex health needs. Importantly, this task can be future
dated so that the person who needs to action the follow-up need only see it when it is timely. It is also
important to document when a follow-up is closed. Follow-ups remain documented in a patient’s chart
for record. In comparison, messaging is more immediate and is usually acted on in a short time frame,
often while the patient is in the clinic. Messaging is often used for many non-patient purposes.
Recommended Wolf Help Files:





Creating Follow-Up Tasks
Viewing Your Follow-up Tasks
Updating or Modifying your Follow-up Tasks
Competing your Follow-up Tasks (IMPORTANT: Click “Completed” to remove task from list!)
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Clinical Decision Support: Population-wide point-ofcare reminders
Wolf has a tool that will search the database for specific criteria to identify patients due for clinical
service. Population-wide point-of-care reminders in Wolf are called “Rules”, and these are just searches
that run in the background of the EMR and provide notifications when a patient meets the criteria.
These can be created based on internal clinic information such as charting, scanned documents, billing or
external information such as incoming lab or imaging data. These point-of-care reminders will
automatically go away when the search criteria are met. Population-wide reminders are key enablers of
proactive panel-based care. The higher the data quality in a practice, the more reminders a practice team
can create and use reliably.
Recognizing that individual patient care will be tailored and that there are exceptions to the rules,
reminders generally can be individualized for patients and modes of documenting exemptions may exist.

Individual Patient Alerts
At the patient level, Wolf has the ability to create a note or alert for an individual patient. Individual
patient alerts can vary from critical pop-ups to notes that appear in certain areas of the EMR such as
scheduling, the Workdesk or in charting. Be sure all staff and physicians are aware of how flags are used.
Try to avoid variation in where things are documented at all times. The options are:


Scheduler: Flag appears in the notes tab of Patience Maintenance
o Booking Alert- This is ideal for staff working on the scheduler. There are two booking
alert options: a pop up flag when booking a patient or when arriving a patient. These
notes remain in the chart until you remove them. So delete what was done and keep
them current.
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o



“The Pin” – The red pin in the scheduler can make a short note that can be seen when
you hover over the patients name in the scheduler. Pin notes do not appear in any other
parts of the chart. Physicians rarely see them.

Rules: Flag in both the patient chart and Workdesk
o Chart
o Workdesk
(Rule notifications in the chart below the name band)

(Rule notifications on the Workdesk)

Recommended Wolf Help files:
 Practice Search Rules
 Practice Search Rule Exemptions
 Managing patient Rule Matches (from the Workdesk)
See Useful TOP Videos: http://www.topalbertadoctors.org/tools--resources/emrsupports/#8


Proactive Preventive Screening Care using Rules and Messages
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Panel Management Processes
Preventive Screening
As per the Alberta Screening and Prevention (ASaP) Program:
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Documenting for ASaP
It is important that all ASaP maneuvers are documented in a consistent manner, ideally in a searchable
field in the EMR.








BP, Height and Weight are recorded as vitals
Lifestyle/modifiable risk factors are often recorded in an exam template, designated area or a
manual lab – see more about this in the Lifestyle/Modifiable Risk Factors section
Influenza screening includes:
1. Administering a vaccine
2. Recording of vaccination administered elsewhere
3. Record of offer to vaccinate or counsel
The following are documented as investigations/scanned documents/ manual lab results:
1. Colorectal cancer screening – FIT
2. Pap test
3. Plasma Lipid Profile
4. Diabetes screening (HbA1c or fasting glucose)
Colonoscopy, Mammography and sigmoidoscopy (depending on where you are in the province)
are usually documented as a scanned report. When received it is important that these are
named/linked appropriately in a standardized way, (e.g., “Colonoscopy Report”)

Documenting CV Risk Calculation Principles






This is a highly valuable tool to assess risk in patients with no previous cardiovascular disease
(e.g., NOT taking a ‘statin’ class of medication).
Patients already at risk, such as those taking a statin, do not need to be assessed.
The preventive care screening search is to identify patients 40 – 74 y, not taking a ‘statin’, that
have not had a CV Risk calculation in the past 5 years
Requires other data held in the EMR: gender, tobacco use, BP, non-fasting lipid data and
diabetes diagnosis (for some CV Risk calculators)
May use an internal EMR CV Risk Calculator or an external calculator such as:
http://chd.bestsciencemedicine.com/calc2html#basic
1. Dependency on where the provider records the result or if it is auto created from the
internal calculator in the EMR
2. In Wolf this is recorded in the Framingham. From the chart, in the right click menu near
the bottom is CV Risk Calculator. Labs, vitals and smoking status will auto populate to
assist you.

Special Note: In order for the risk percentage to save, choose to “Print” the worksheet, then cancel
the Print. If you do not “Print”, the Framingham will not save.

To conduct a CV Risk Calculation, access the Cardiac Risk Worksheet:
 Using the SMART Menu (Right Mouse Menu)
 From a SOAP note
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While in the Cardiac Risk Worksheet, if the print icon is used, a document is created with the document
keyword “Cardiovascular Risk Profile” that is available in the Document Tab of the patient’s Medical
Summary.

Recommended Wolf Help files:


Cardiac Risk Worksheet
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ASaP Program Participation
Providers registered in the ASaP Program with TOP will use chart review methodology to look for results
of completed screens as well as offers, declines or exemptions. Consistency of recording assists in the
chart review.

ASaP EMR Extraction Methodology for Schedule B
Practices and PCNs measuring ASaP results for Schedule B purposes using EMR extraction methodology
need only focus on the record of results (have a screen completed) which, in general, is easier to search
in the EMRs than offers, declines and exemptions.

Exclusions/Exemptions
Some patients are excluded from general adult preventive screening for clinical reasons. Developing
consistent processes to document the exclusions assists the team in collaborating on preventive
screening care. All exclusions often require a standardized entry somewhere in the chart to support the
workflows. Some exclusions/exemptions are:
 Females with a complete bilateral mastectomy are excluded from mammograms
 Females with a total hysterectomy (no longer have a cervix) are excluded from pap smears
 Patients with documented cardiovascular risk and treatment no longer are screened for CV risk
and may have different intervals for lipid profiles
 Patients diagnosed with diabetes are not screened for diabetes.
 When diagnosed and undergoing interventions for colorectal, breast or cervical cancers, the
routine screening intervals no longer apply, and patients will follow their recommended care




Special Note: If the clinic has not yet begun using Rules for Chronic Disease work, then
leaving the screening interval in place can be beneficial. Diabetic or not, every patient over 40
should be screened or monitored for diabetes because they HAVE diabetes. (The more
frequent completion of chronic disease testing satisfies ASaP screening intervals.)
For any potential exclusion criterion, discuss with your provider before modifying the Rules. If
the clinic has not yet implemented or determined the best workflow to apply exclusion
criteria, leave the Basic ASaP Rule/ Search in place. If the Rule is more inclusive, then patients
can be individually exempted.

A team should consider how documentation of the exemption criteria impacts team-based screening
care. Approaching this often depends on physician preferences. Discuss as a team and agree on what the
workflow will be. Ensure the whole team including new staff joining later are aware and follow it
consistently.
Scenario:
A female patient is offered a pap but remarks that she has had a total hysterectomy 10 years ago and asks
if she needs one. The clinic team member indicates no. The team notes that the reason they didn’t know
was because the evidence of the hysterectomy was in a chart under “surgical procedures”. The team
wants to ensure this doesn’t happen again and agrees that possible actions they can take are that:
- The total hysterectomy needs to be added to Past Hx tab> Surgeries and Procedures area of the
chart
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-

The surgical report is coded with the additional term “Total Hysterectomy”
The patient is exempted from the population-wide reminder for pap smears in the clinic

ASaP Searches and Rules
There are 2 general approaches for completing the ASaP specific searches:
1. Searching for patients due for an ASaP maneuver. We use this approach to build lists for
opportunistic and outreach screening processes. Rules can double as an overdue reminder in the
chart and as a search. If the doc wants to screen more frequently than the rule will handle this.
Special Note: Note: if you use the Rule as a search, then you are searching patients who have
NOT had a screen completed. If you are searching number of screens completed, you can
either create a separate set of searches or make sure you uncheck the exclude matches box.
The disadvantage of using the Rules as Searches, will be, if you happen to change the Rule and
save, it will alter the Rule system wide.
2. Searching for patients who have had the maneuver completed. We generally use this approach
for quality improvement purposes to track how we are doing. Searches can be saved and run
frequently to generate quality improvement rates.
Scenario: Physician requests they only do HBA1C for diabetes screening. But screening rates can
include FBS. It is possible to miss patients if results received from other ordering doctors. Needs
to reflect Schedule B/ ASaP guidelines, not physician preferences.
Special Note: Also important to note that Searches that determine screening rates should
reflect the physicians’ panel. If a clinic team has well-established processes for panel
identification and regular maintenance, the panel report will be accurate at any time (or after
a maintenance cleaning). An active panel is often considered to be 3 year look back (but check
with your physicians for their standards). If at the time of measurement, the person doing the
measurement is uncertain of the state of panel maintenance, searches can include a ‘Last
Visit” filter of 3 years in the denominator.
Rules should not have this filter (a visit in the last 3 years) because if a patient is on a
provider’s panel but has not had a visit in the last 3 years, the rule would NOT show.
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Searches for ASaP Maneuvers
Age and/or Gender Criteria
Patients in a specific age range and gender
Identify patients 18 + with no

Identify females 25-69
Identify females 50 – 74

Identify patients 40 +
Identify patients 40 – 74
Identify patients 50 – 74

Maneuver/Timeframe
have not been screened (seen) in the appropriate
interval (e.g. 3 years)
Height recorded on the chart
Weight recorded on the chart in the past 3 years
Blood Pressure recorded in the last year
Tobacco assessment in the last year
Exercise assessed in the last year
Influenza vaccination nor counsel in the last year
that have not had a Pap test in the past 3 years
have not had a mammogram in the past 2 years (a
mammogram may be a scanned document and/or
an electronic result depending on the region)
have not had a fasting glucose
OR a HbA1c test in the last 5 years
have not had a plasma lipid profile test in the past 5
years
have not had a fecal immunochemical test in the
past 2 years
OR a flex sigmoidoscopy in the past 5 years
OR a colonoscopy in the last 10 years (where a FIT
test is a lab result and a flex sig or colonoscopy can
usually be identified by a scanned report)

In this section we will show an approach for each of the ASaP screening maneuvers. There may be more
than one way to search and it will also depend on your clinic’s documentation. Other approaches will
work but we suggest you validate your search results, whatever approach you take. Since Rules and
Searches are built in the same module, each maneuver will be described both ways and how they differ.
Useful TOP Videos: http://www.topalbertadoctors.org/tools--resources/emrsupports/#8










Disease Management Search in Telus Wolf
Mammogram Search in Telus Wolf
Pap Smear Search in Telus Wolf
Tobacco Use Verified Search in Telus Wolf
Saving a Search as a Rule in Telus Wolf
Simple ASaP Search in Telus Wolf
Mammography Screening Rate in Telus Wolf
Tobacco Screening Rate
Weight BMI Screening Rate in Wolf
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Examples of ASaP Practice Searches (based on completed
screens)
Special Note: ASaP screening is a guideline by which all patients should receive a screen within the
interval recommended and is for the average “well patient”. Once a patient has been diagnosed with a
chronic condition or is at a higher risk, the physician can make a clinical decision to monitor more
frequently. Rules and searches for exclusions, chronic disease, and elevated risk required additional
filters and considerations.

Height screening (Rule)
Patients 18+ with no height recorded in Vitals on the chart. Leave the ‘Observed’ box unchecked.

To make this a search for completed screens:


Uncheck the ‘Exclude matches’ box in the Height filter



Rename and Save as a search



To get your screening rate, divide number of patients in the search by number of patients in the
panel over the age of 18.
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Weight Screening (Rule)
Patients 18+ with no weight recorded in Vitals on the chart in the past 3 years.

To make this a search for completed screens:


Uncheck the ‘Exclude matches’ box in the Weight filter



Rename and Save as a search



To get your screening rate, divide number of patients in the search by number of patients in the
panel over the age of 18.
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Blood Pressure Screening (Rule)
Patients 18 + without a Blood Pressure recorded in the Vitals area in the last one year.

To make this a search for completed screens:


Uncheck the ‘Exclude matches’ box in the Systolic BP filter



Rename and Save as a search



To get your screening rate, divide number of patients in the search by number of patients in the
panel over the age of 18.

Pap Screening (Rule)
Females 25-69 years old that have not had a Pap test in the past 3 years. Be aware that paps can be
potentially pulled from three areas of Wolf. Choose the best option for the clinic.
Before creating this, it is necessary to identify how the pap is coded by the regional lab service and
received in the EMR. In Calgary lab zone it is coded as “Gyn Cytology”. In the Edmonton zone it is coded
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as “anatomical pathology”. Look in a chart with a pap result under Investigations to see how it has been
coded by the lab.

Another point of awareness is the use of the Preventive Care Procedures area of Wolf on the
Investigations tab of the Medical Summary. This field is also searchable independent of the lab results. If a
provider documents all interpretations in the Preventive Care Procedures area, it is searchable from there
as well. In Practice Search it may be searched under History > PAPS





PAPS: Will pull from Preventive Care Procedures. Not ideal for reporting.
Lab Result: Will pull from electronically received results. Ideal if ALL Paps arrive electronically.
Lab Result or Document: Will pull from investigations or scanned documents. This is ideal if you
receive electronically and also scan, (e.g. if you retrieve results from Netcare for new patients, or
test is done in another region). This tends to be the best choice as many women go to pap clinics
or female physicians outside their primary provider’s clinic. For AsaP reporting, this option
captures the majority of possible completed screens.
Exclusion Criteria: Female patients that have had a surgery documented as a “total
hysterectomy” for benign disease may be excluded from a preventive care search for a pap,
however, most practices have not had reliable and consistent documentations of surgery in the
patient history tab, so it may be safer to include all patients and exempt patients from Practice
Search Rules individually. This decision in Practice Search may be made by practice or by provider.
Patients with a subtotal hysterectomy and retained cervix continue with screening as per cervical
cancer guidelines.
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Anatomical pathology




In Calgary lab zone this area should read: “Gyn Cytology”
In the DKML/Edmonton zone this area should read: “anatomical pathology”, Where Text “Has
Phrase cervical”.

To make this a search for completed screens:


Uncheck the ‘Exclude matches’ box in the Lab Result filter



Rename and Save as a search



To get your screening rate, divide number of patients in the search by number of Female patients
25-69, in the panel.
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Diabetes Screening (Rule)
All patients 40 + that have not had a fasting glucose OR a HbA1c test in the last 5 years

Option: If the Problem List is reliable and coded consistently, patients with the diagnosis and problem
entry of Diabetes may be excluded from this search using History – Problem (ICD9) or History – Problem
(Specific) and “Exclude Matches”. Another consideration is, if the problem list is unreliable, patients with
a diagnosis of diabetes should be having a test for HbA1c or fasting glucose more often than once every 5
years anyway and would not flag a Rule.

To make this a search for completed screens:


Uncheck the ‘Exclude matches’ box in the Lab Result filter



Rename and Save as a search



To get your screening rate, divide number of patients in the search by number of patients over 40
years old, in the panel.
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Lipids Screening (Rule)
All patients, 50 – 74 y that have not had a lipid profile in the past 5 years.
A lipid profile includes total cholesterol, HDL, LDL and triglycerides. Since HDL, total cholesterol
and triglycerides may be ordered separately, an LDL result usually indicates a completed lipid
profile. Discuss with your provider to review nuances. LDL cannot be calculated if the
Triglycerides are really elevated. Determine whether to look for an individual test or multiple
tests.

Option: Patients already identified at risk of cardiovascular disease and are taking a Statin (HMG CoA
Reductase Inhibitor) are no longer being screened for lipids (because they are already identified at being
at risk) and lipid screening is no longer required in this population, as per the Prevention and
Management of CVC Risk in Primary Care Clinical Practice Guideline. Lipid monitoring is then the standard
of care at an increased interval.
So if the problem list or medications list is not 100% reliable, you can leave the screening in place as it will
not likely flag a Rule on the chart. If the active medication list in the EMR is reliable, to Exclude Matches of
patient taking this medication, this may be added in practice Search:
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Special Note: Above is an example of how you might exclude add the medication filter to exclude a
patient for Lipid screening. Similarly, diabetics can be excluded this way (with the appropriate
medication). Cervical screening and Mammograms can be excluded by using the Surgery Filter. Ideally
the entries under surgeries are should be standardized to ensure the filter works properly.

To make this a search for completed screens:


Uncheck the ‘Exclude matches’ box in the Lab Result filter



Rename and Save as a search



To get your screening rate, divide number of patients in the search by number of patients
between 40-74 years old, in the panel.
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Cardiovascular Risk Screening (Rule)
All patients 40 – 74 yrs, that have NOT had a cardiovascular risk calculation/cardiac risk worksheet in the
past 5 years

To exclude patients currently taking a statin class of medication (HMG-CoA reductase inhibitor) from the
search for patients that have not had a cardiovascular risk calculation:
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To make this a search for completed screens:


Uncheck the ‘Exclude matches’ box in the documents filter. Remove any medication exclusion.



Rename and Save as a search



To get your screening rate, divide number of patients in the search by number of patients
between 40-74 years old, in the panel.
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Mammogram Screening
Females’ 50 – 74 y that have not had a mammogram in the past 2 years (a mammogram may be a
scanned document (using a standardized keyword), Preventive Care Procedure documented and/or an
electronic result, depending on the region).

.





Documents: Will pull from scanned reports using a standardized keyword. Best choice if you scan
all Mammograms.
Mammograms: Will pull from Preventive Care Procedures. Not ideal for reporting.
Lab Result (Received): Will pull from electronically received results. Ideal if all mammograms
arrive electronically.
Lab Result or Document: Will pull from investigations or scanned documents. This is ideal if you
receive electronically and also scan, (e.g. if you retrieve and scan from Netcare; for new patients,
or test is done in another region)

To make this a search for completed screens:




Uncheck the ‘Exclude matches’ box in the Documents OR Lab Result filter (as appropriate)
Rename and Save as a search
To get your screening rate, divide number of patients in the search by number of female patients
between 50-74 years old, in the panel.
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Colorectal Screening
All patients 50 – 74 y that have not had a fecal immunochemical test (FIT) in the past 2 years OR a flex
sigmoidoscopy in the past 5 years OR a colonoscopy in the last 10 years (where a FIT test is a lab result
and a flex sig or colonoscopy can usually be identified by a scanned report).This search relies on
consistent document keywords for colonoscopy and sigmoidoscopy reports.

Note: Wolf logic, using Lab or Document, cannot account for both Sigmoidoscopy and Colonoscopy documents with
different Intervals (it can only have two or more documents with the same interval). As Sigmoidoscopies are more
infrequent, search them separately and add the number to your numerator.

To make this a search for completed screens:




Uncheck the ‘Exclude matches’ box in the Lab Result or Document filter
Rename and Save as a search
To get your screening rate, divide number of patients in the search by number of patients
between 50-74 years old in the panel.
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Lifestyle/Modifiable Risk Factors (ASaP+)
Modifiable risk factors should be recorded in a consistent fashion to enable preventive screening care as
well as to monitor and manage patients who screen positive. All members of the clinic team should know
where modifiable risk factors are recorded in the EMR and who is responsible for entering them. It is
recommended to enter modifiable risk factors in an area of the EMR that is searchable and can enable a
population-wide reminder.
 Height and weight (to calculate BMI and weight changes)
 Exercise (Physical Activity)
 Tobacco Use
 Alcohol Use
 Diet – Fruit and Vegetable Consumption
Drop Down menus: Wolf does not supply a great deal of options in the drop-down menus. The drop
downs for Alcohol can be configured by a clinic Wolf Administrator with your preferred options in
Configuration > View > Patient Data Codes > Alcohol Consumption Levels

Tobacco Screening (Rule)
All patients 18+ that have not had a tobacco use assessment in the past year.
Identifying whether patients have not had a tobacco use assessment will depend on where tobacco
use is documented. It is recommended to document tobacco use in the Personal Risks area of the
chart. This is accessible from the SMART menu (right click menu) or in the Personal Hx tab in the
Harmful Substances area. This is the only place to document tobacco use that will impact the SMART
banner.

Special Note: In Harmful Substances, anytime you validate a Tobacco or Alcohol status OR make a
change, the verify box must be checked. Re-checking the “verified” box stamps the date it was done.
That date is used to determine how long since last assessed.
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In Practice Search, to identify patients 18+ that have not had their tobacco status verified in the past
year, use the following search.

To make this a search for completed screens:


Uncheck the ‘Exclude matches’ box in the habits verified filter



Rename and Save as a search



To get your screening rate, divide number of patients in the search by number of patients over 18
years old, in the panel.
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Alcohol Screening (Rule)
All patients 18+ that have not had an alcohol use assessment in the past year. It is recommended to
document alcohol use in the Personal Risks area of the chart. This is accessible from the SMART menu
(right click menu) or in the Personal Hx tab in the Harmful Substances area. Any notes made in a SOAP
notes cannot be reported.

To make this a search for completed screens:


Uncheck the ‘Exclude matches’ box in the habits verified filter



Rename and Save as a search



To get your screening rate, divide number of patients in the search by number of patients over 18
years old, in the panel.
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Exercise Screening (Rule)
All patients over 18+ due for exercise assessment.
In Wolf EMR there is no pre-built field for exercise assessment. To document (as per the ASaP
recommendations to assess patients that are above or below the recommendation of 30 minutes 5 days
per week, or 20 to 25 minutes every day; major muscle groups and bone strengthening activity >2 days
per week) another field must be used.
One option is to use an exam template with a designated field for exercise assessment. This can be
created using the Custom Exam Template Wizard, or available from TOP.
Exercise recorded in a custom exam template:

Custom exam field searched in Practice Search to identify patients without the exercise field used
in the last year:
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Other approaches to recording and measuring exercise are:
1. Configure Manual lab results, may require assistance for set-up. See Manual_Lab_Entry
 Create an Investigation Type called screening in configuration and an
Investigation called Exercise Assessment
 This will allow any team member to record that an exercise assessment was
completed and measured in Practice Search
2. Auto-text replace can be used to create a consistent term for exercise assessment and
thus it is searchable in practice search.

To make this a search for completed screens:




Uncheck the ‘Exclude matches’ box in the Systolic BP filter
Rename and Save as a search
To get your screening rate, divide number of patients in the search by number of patients over 18
years old, in the panel.

Fruits and Vegetables Screening (Rule)
All patients over 18+ due for a fruits and vegetables consumption review. The best option for recording
fruits and vegetable consumption is with a Manual Lab Entry. Configure the investigation types. Ensure
the team knows how to capture appropriately. From the right click menu in a chart, select New Manual
Lab Result, then enter as in the screenshot below.
Recommended Wolf Help files:


Customizing Investigations and investigation types

All patients over 18+ due for Fruits and Vegetables assessment.
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Use this filter when searching manual lab entries

To make this a search for completed screens:


Uncheck the ‘Exclude matches’ box in the lab result filter



Rename and Save as a search



To get your screening rate, divide number of patients in the search by number of patients over 18
years old, in the panel,
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Disease Management
Beneficial Searches for Disease Management


Patients with a given diagnosis with:
o
o
o

No clinic visits in a period of time
A monitoring test not completed in a period of time
Monitoring tests that have values above a threshold (e.g. Reference Range)

Chronic Disease Management
Proactive panel-based care of a cohort of patients with a given condition (e.g., diabetes or hypertension)
is enabled by certain EMR features:
 Problem list – See Appendix B – Sample Lists
 Point-of-care reminders set for a population of patients (Rules)
 Pop-up notifications in various areas of the EMR (Alerts in Patient Maintenance, Active Notes)
 Follow-ups, worklists (Practice Searches)
While patients with chronic conditions are treated and managed as individuals, processes for proactive
panel-based care act as an extra “safety-net” to identify patients that may be due for care.
Example:
Peter is a chronic disease nurse that works for a PCN and a clinic. Peter has collaborated with the panel
manager, who is very savvy at EMR searches, to build a number of saved searches that he runs weekly
that support his work for chronic disease management. Peter has access to the clinic EMR remotely so he
can run these searches and contact patients on days when he is not embedded in the clinic. The diabetes
searches that the panel manager built for Peter are:


List of patients with a diagnosis of diabetes and no clinic visit in the last 6 months and no future
visits booked in the next month



List of patients with a diagnosis of diabetes that have not had an HbA1c result in the last 6
months



List of patients with a diagnosis of diabetes, whose last HbA1c result was over 7.0

Peter reviews the lists as part of his regular work as a chronic disease management nurse and calls the
patients appropriately for follow-up or he may task another team member to call the patient to book an
appointment.
Example 1:
A panel manager at a clinic does a search that produces a list on a monthly basis for patients with
chronic conditions such as diabetes or chronic kidney disease that have had NO VISITS (and no
future visits booked) in a period of time (e.g., 6 months or a year, depending on the condition).
This allows the panel manager to reach out to these patients, confirm that they are still patients
of their primary provider at the clinic, and offer a management appointment.
Example 2:
A panel manager uses lab data to run a monthly search in the EMR to identify patients that have
lapsed in getting lab tests done that support management of their condition. For example, a
monthly search identifies any patient with a diagnosis of diabetes with no HbA1c result on file in
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a period of time, such as 6 or 7 months. The clinic may set protocol for the panel manager to act
on this list or the list may be provided to the CDM nurse for action.
Example 3:
A panel manager has created a search in the EMR for the CDM nurse that produces a list of all
patients with a diagnosis of diabetes that displays the patient’s last lab values for HbA1c, fasting
glucose, blood pressure and last visit date. The CDM nurse runs the search on a weekly basis and
can sort columns in the report to identify patients that may need follow-up. By running the
search live in the EMR the CDM nurse can easily click on the patient’s name to be directed to
their chart to get more information for next steps.
These examples identify ways that clinics can set up processes that act as a “safety-net” and be proactive
in identifying patients early for interventions.
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Chronic Disease Management Searches – Examples
Example 1: Practice Search for any patient with Diabetes in the Problem List but has not had a HBA1C in
the last 6 months.
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Example 2: Practice Search of patients with Diabetes and Hypertension but have not had a visit in more
than 6 months.

Registries
A disease registry, identifying patients with a coded disease condition, is the first step in preparing for
panel management of patients of a given condition. The process of coding patients with a condition to
produce a list is called a ‘patient registry’. Ideally, all patients with a condition will have the condition
noted in their ‘Problem List’ in a consistent way. For example, Diabetes is always called ‘Diabetes Mellitus’
and will likely have the ‘250’ ICD-9 code attached to it. It is important that an entire practice agree on
terms for the conditions to create registries. In this example Diabetes is not named with other
inconsistent terms such as ‘Diabetes’, ‘DMII’, ‘DM2’, ‘Diabetes M’, etc.
TIP: Free typing in the problem list is NOT recommended. Physicians should
use the drop down list when coding problems. In some cases a “clean-up” of
the list may be needed to enable consistent coding moving forward.
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While the Service Codes used in claims or billing is a very useful search to inform the practice when
forming registries, it is not in itself accurate enough to be used when creating point of care reminders. An
accurate problem list should be the trigger for the point of care reminders.

Problem Lists
Wolf has a designated area to enter confirmed diagnoses in the problem list. Agreeing as a team to have
consistent entry into one area in a consistent way is critical to enable team-based care of patients with
chronic conditions.
There are useful searches that will support creation of disease registries. By looking in other areas of the
EMR, patients without the problem in their ‘Problem List’ can be identified. See Appendix B – Sample Lists
Feature of EMR

Billing
Medications
Lab

Example 1
Data that would inform Diabetes
Mellitus Registry
Diagnostic code 250
Currently taking metformin or
insulin
HbA1c over 7 %

Example 2
Data that would inform
Hypertension registry
Diagnostic code 401
Currently taking an
antihypertensive
BP > value specified by clinic MDs

The bulk action feature from reporting area of the EMR is a useful tool when producing a list of verified
patients with a given condition to add it to the patient problem list in bulk.
A useful search to help populate problem lists with Chronic Conditions is shown here. This Practice Search
looks for patients billed at 250 (Diabetes) ICD9 code but does not have Diabetes in the Problem List.
Note: This search looks for patients billed in the last 3 years. If a time is not defined you will get a list
of every patient ever seen by that physician. Targeting your cleanup of the problem lists is better
than trying to clean up the entire database. Migrated data may affect your ability to do this.
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This is particularly useful if the providers have not utilized the Problem List fully. If the clinic chooses to
undergo this type of “clean up”, be sure to review the list of patients with their provider to ensure these
patients are actual Diabetics and not coded because they were pre-diabetic or some other reason than
Diabetes. Do not use “Bulk Actions” or alter patient charts without discussing with provider.

74

Care of Patient with Complex Health Needs
Patients Collaborating with Teams (PaCT)
PaCT is a next step in the Patients Medical Home journey. The next opportunity to positively impact care
for those with the most complex health needs, including those at risk for or having multiple chronic
diseases.

Care Planning
“The process by which healthcare professionals and patients discuss, agree upon, and review an
action plan to achieve the goals or behavior change of most relevance and concern to the
patient.”

PaCT Care Planning Process
http://www.topalbertadoctors.org/pact/

PaCT Resources
PaCT Resources can be found here: http://www.topalbertadoctors.org/pact/toolsresources/

PaCT Processes
Clinics participating in PaCT will need to have well-established processes for panel identification and
maintenance to ensure that they are offering care planning to their confirmed patients. Once the Central
Patient Attachment Registry (CPAR) is available, it is recommended that clinics participate to ensure that
they are offering care planning to their CPAR verified patients.
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This section of the EMR guide focusing on PaCT is intended to be used by teams alongside the PaCT HowTo Guide. The sections below follow the “Potentially Better Practices” as they relate to the “Optimize
EMR” focus of each phase.
PaCT Pre-work


Uploading the Care Planning Template into your EMR
See Appendix A- Care Planning Template
 Discuss and agree upon standard charting procedures for team-based care
PaCT Identify Phase:
 Identifying patients with complex health needs
 Marking the patient’s chart with “Complex Health”
PaCT Prepare Phase:
 Appending relevant patient assessment information to the record.
 Pre-populating the care planning template
 Generating requisitions
PaCT Plan Phase:


Care Planning Template Use:
o Standardizing documentation to enhance pre-population
o Optimizing documentation during the appointment
 Creating reminders for follow up appointments
PaCT Manage Phase:




Maintaining the care planning document over time
Creating reminders for planned care interventions
Standardizing processes for referral tracking

PaCT Pre-work
Uploading the Care Planning Template into your EMR
A new care planning template has been created for the PaCT initiative that is patient-centered and relies
on evidence-based care planning principles. For processes on how to make the template available in your
clinic EMR, use the template at the care planning visit, save and use for follow-up visits, see your Wolf
Help File “EMR Smart Forms User Guide” EMR specific tip sheet.
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Discuss and agree upon standard charting procedures for
team based care
Care planning is a team activity. For this to occur there should be general protocol on where information
is stored in the chart so that all team members can both contribute to the chart, find information in the
chart and contribute to the care plan appropriately. This would impact team members of diverse roles
across the practice: scanners, medical office assistants, nurses, pharmacists, physicians, etc. In summary,
chart in a way that team members can help care for the patient. Some benefits include:




Care team members know where to find the information.
The patient’s data can inform population-wide reminders to alert when care services are due
Monitoring and management can be done systematically

Identify Phase
Identify patients with Complex Health Needs
The first step in the care planning process is to identify patients for care planning. Your PaCT team will
have reviewed the suggested menu for selecting a patient population (see menu below). In the EMRspecific Guides you will see suggested approaches to searching each of the menu items.
Part of the improvement process for you team may be improving how your selected population is
identified by your EMR. For instance, if you select ‘frail patient’s’ as your focus, you may have to work on
how frailty is documented to make it reliably searchable.

77

Menu of Ideas
Clinical Criteria

Risk Factors

Utilization Parameters

 People with advanced illness

 Age (e.g., > 85, or >  Many visits (e.g., > 10) in the last
75)
year

 Complex Conditions: (Multiple
Sclerosis, Parkinson’s Disease  Frailty (via Manual  Hospitalizations (2 or more within
or Lupus)
lab entries)
the past year) (via Scanned
document keywords)
 Dementia (via Problem List)
 Modifiable
risk
factors
 ER visits (3 or more) in the past year
 Multiple Chronic Conditions
(e.g., 3 or more)
 Social risk factors
 Had a care plan in the past but not
in the last year
 Patient eligible for a Complex  High risk (using
Care Plan
predictive
risk  Receiving home health services
assessment tool)
 Multiple medications
 No visits to the clinic in the last year
(with risk factors or a chronic
 Functional impairment
condition)
 Adults
under
65
with
disabilities

*Note – these are some main considerations – not an exhaustive list
Other patient data will be used to inform a team if a patient is appropriate for or due for care planning.
Data that a team may use for this purpose includes:


Visits:
o Date since last visit. Searching for patients with chronic conditions or risk factors that
have had a lapse since their last visit (e.g., one year) may represent patients due for care
planning (see Care_Planning_Searches)
o Number of patient visits to the clinic. This is searched from the number of appointments
or visits. Some patients with many visits to the clinic (e.g., > 10/year) may assist the clinic
in identifying patients with complex health needs.
o Additionally, for a walk in clinic, searching for a frequent number of visits over a 6 month
or one year period is useful. Frequent visitors can be noted and asked if they wish to
attach to a provider to improve continuity.

Note: In the search below, Walk-in patients are assigned to a primary MD named “Walk-in”. The search will
depend on how you assign Walk-In patients. If you use the Patient status for walk-ins, then use this filter
instead of Primary MD.
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Hospitalization and/or ER reports. These are external documents received at the clinic, usually as
a fax/e-fax. In this case how these are indexed/named and attached to the chart matters. With
consistent naming protocol, the number of hospital and/or ER reports can be found for a patient.
In Wolf these are often scanned into the Documents tab.



Scanned documents:
o Past care plans. If care plans are consistently named and linked in the patient’s chart,
past care plans can be found and as the date they are indexed can be determined, these
can inform follow-up visits or follow-up care plans. The billing of the care plan can also be
used to inform follow-up (See Care_Planning_Searches)
o Reports and referrals,
Home health services. Documenting in a consistent way which patients receive home health
services would assist in identifying all these patients; some of which will represent patients with
complex health needs. Process for documenting can vary. Discuss a consistent approach with
your provider.



Recording “Complex Health Needs” in the EMR (Critical
Step)
A critical step to monitor and follow-up with patients with complex health needs is to have one place in
the EMR where the term “complex health needs” is recorded and is searchable; it is also beneficial if it is
searchable for your quality improvement measures. As a clinic, determine and agree on one place it will
be recorded. It is recommended that this be in the:
 Problem List (The term “Complex Health” may need to be added to the Problem List master list of
terms by the clinic’s EMR administrator.) See Sample Problem Lists – Appendix B
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See the TOP EMR Video: http://www.topalbertadoctors.org/tools--resources/emrsupports/#8



Managing Master Problem List in Telus Wolf
Complex Health for PaCT in Telus Wolf

Prepare Phase
Append patient assessment information to the record
Some patients identified for care planning may have seen other providers and had various diagnostic, lab
or other tests completed that may be relevant to the care planning process. Some of this information
might be available on Netcare. This potentially better practice suggests that someone from the care team
looks at Netcare for relevant information and adds it to the EMR in a standardized way. There are two
main ways in which to do this:
1. Scan reports such as Mammograms, Colonoscopies, Discharge Summaries, etc.
2. Create Manual Lab entries for various bloodwork. Labs often arrive with many results on one
page. Scanning will not give you enough detail or data to satisfy the Rules or pull data through
to the Flowsheets. Manually enter things like HBA1C, Lipids, FBS, FIT, etc.
See Foundation for Success - Commitment to Standardization in the EMR

Populate care plan template with known information in
advance of the encounter
Some EMR data can be entered once in the patient’s chart and then flow to the care plan (mapped). By
charting this way team members will save time when looking for information and it will take less time to
create the care plan and there will be less chance of data discrepancies and errors. Data that can be
mapped in most EMR’s includes:











Emergency Contact Info
Current Problems/ Problem List
Medications – Current (OTC & Rx) & Failed
Allergies
Family Medical History
Significant Historical Medical Events / Past Medical History/ Surgeries
Test & Treatments
Labs
Diagnostic Imaging
Modifiable Risk Factors including Tobacco, Alcohol, Exercise, Obesity (BMI), Diet of Fruit &
Vegetables

Other data that is less likely to be mapped in most EMRs should be charted in a consistent way so that the
team knows where to enter it and where to find it in the record when working on the care plan with the
patient. Such data includes:
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Care Team Members
Medical Team Members
Social History (Risk Factors)
Frailty Identifier (Can be done in Wolf if entered correctly)
Medical and Assistive device
Personal Care Directives
Goals of Care
Follow ups
NOTE: How and where you capture information in the EMR will
determine the amount of information that can be mapped/linked
to the Care Planning Template (see appendices).

See Wolf EMR Help Files:





Smart Tags
Working with “Send to Word” templates
SMART forms
Adding Bookmarks to a SMART form

Generate lab and/or diagnostic imaging requisitions in
advance of the encounter
EMRs have requisitions for laboratory and diagnostic imaging that are generated from the system. If your
team is not using this feature, this is an opportunity to begin using this feature to proactively generate
and provide requisitions to patients in advance of appointments.
Some EMRs have built in capabilities to e-fax directly from the system to the lab or imaging centre of the
patient’s choice. There are also a number of third party software options that allow for secure electronic
transmission of requisitions.

Plan Phase
Documenting in the care planning template
In the prepare phase, the care plan template activities focused on populating the template before the
patient arrives for their appointment. (See Appendix A) In this section, the change is the population of the
template during the appointment. These sections include:








Medical goals and targets
Patient goals (health and life)
Medical action plan
Patient self-management action plan
Potential barriers and coping plan
Follow-up plan (who, when what, next visit)
other identified care team members outside of the clinic or PCN involved in the patient’s care
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Some teams will already be used to charting during the appointment. The goal is to have the information
in the template by the end of the appointment with the patient so that you can print a copy for the
patient.
It is suggested that you check settings on your EMR to see if/how you can print in a font size appropriate
for the patient.

Set a reminder in your EMR for follow up appointments
In Wolf, Follow-ups are used to set a reminder to the appropriate staff member to call a patient in for
follow up. The patient should be aware of the follow up date based on their care planning follow up plan
but many will still want or need a follow up call. Many clinics already use this function in some capacity
but there may be additional considerations for care planning that could be discussed.

Manage Phase
Maintaining the care planning document over time
As patients come in for follow up appointments there will be a need to add, delete and change
information in the care planning template. Each EMR will handle this task in a slightly different way and
you will need to become familiar with how your EMR handles this and what is optimal for you and your
team. Over time, you may wish to start a new template which may be based on time or the volume of
change over time for each patient. In Wolf, the last care planning template can be opened from the
Documents tab, then saved as a new document with changes. This will make the last document the most
current one and save all versions of the previous care plans.

Creating reminders for planned care interventions
Most EMRs have a reminder system where you can be reminded during the appointment that a care
intervention is due or where you can create searches for certain interventions overdue/coming due. In
Wolf there are three ways to do this:
1. Appointment/ Booking notes
2. Messages or Tasks
3. Rules
There are advantages and disadvantages to each option. Review your workflow with team and choose the
best option for your clinic.

Standardizing processes for referral tracking
Most clinics have processes for tracking referrals to specialists, programs and services. Participation in
PaCT may be an opportunity to review processes and examine some of the features in your EMR for more
effective referral tracking.

Measurement
While implementing the Patient’s Medical Home, a practice or team will not know how they are doing
unless they measure for improvement. Process measures reflect the things that are done in the practice
and how the systems are operating. Example measures are:
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Confirmation/Validation Rate3
It is useful is to measure how often the team is confirming the patient demographic information (address
and phone) and physician attachment. When a clinic is new to the process of patient confirmation it can
be measured in the search tool.

Process Measure(s)
For example a team that wants to measure how they did in a week:
# patients confirmed this week
# patients with visits this week

x 100 = confirmation rate (%)

A clinic may also have an expectation over a period of time and can determine if the validation goals are
being met. For example if a practice has an expectation that their validation rate over a 3 month period
should be 95% the formula would be:
# patients confirmed in the last 3 months
# patients with visits in the last 3 months

x 100 = confirmed rate (%)

Outcomes Measure (3 years)
Overtime a clinic can use an agreed upon timeframe (e.g. 3 yrs.) to determine that the confirmation of
attachment percentage to their most responsible primary provider and team has been sustained.
# patients confirmed in the 3 years
# patients with visits in the 3 months

x 100 = confirmed rate (%)

For all the above calculation by adding all the individual primary provider percentages a comprehensive
clinic’s percentage for confirmation can also be determined.
Appendix D: Calculating Panel and Clinic Confirmation Rates Worksheet

Screening Rate Based on Completed Screens
A practice will also find that they are able to measure rates for preventive screening care. Measuring
completed screens looks for completed results. The generic equation is:

#active, panelled and *eligible patients with a completed
Screen during the *screening interval
# active, panelled patients *eligible for the screen

X 100 = screening rate (%)

When patient demographics and primary provider relationship are checked at the clinic that is called
confirmation even though the box in the EMR may be called “verified” or “validated”. A confirmed
patient panel is produced at the clinic through this process. The Central Patient Attachment Registry will
verify the patients on the confirmed panel to identify only those patients attached uniquely to that
primary provider.
3
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*Eligibility = age and gender specific criteria
*Active = Determine active definition by clinic, (e.g. seen in the last 3 years). Can also mean
marked Active in the Status field
*Screening interval is the time frame during which the screening maneuver should be done,
according to the ASaP Maneuvers Menu.
* The eligible population would include all the patients on a provider’s panel whether they came into the
clinic or not as all rates are calculated over the paneled population.
Example 1: Dr. Brown wishes to calculate the completed blood pressure screening rate for her active
paneled adult patients. Blood pressure should be measured annually (ASaP)
# active, panelled patients* (18 +) with a BP result in the last year x 100 = BP screening rate (%)
# active, panelled patients* (18 +)
Example 2: Dr. Brown wishes to calculate the completed diabetes screening rate for her active, paneled
patients. Diabetes screening is:
 appropriate for adults 40 +
 recommended once every 5 years
 completed with a fasting glucose, hemoglobin A1c result or a diabetes risk calculator score
# active, panelled patients (40 +) with a fasting glucose
OR HbA1c OR diabetes risk score in the last 5 years
# active, panelled patients (40+)

x 100 = Diabetes Screening Rate (%)

Calculating a Screening Rate Based on Offers of
Screening Care
Practitioners participating in the Alberta Screening and Prevention improvement project will include both
completed screens and offers of the screen. In this case, to measure with the EMR there must be a place
that declined, deferred and exemptions for screening are reliably recorded. In this case the generic
equation is:
#active, panelled and *eligible patients with an offer or completed
Screen during the *screening interval
X 100 = screening rate (%)
# active, panelled patients *eligible for the screen

Appendix D: Calculating Panel and Clinic Confirmation Rates Worksheet
It is recommended to use the chart audit methodology4 instead of EMR measures if the offers of screening
care are unable to be searched in the EMR.
4

See ASaP EMR Chart Review Instructions: http://www.topalbertadoctors.org/file/asap-chart-reviewinstructions-emr.pdf
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Disease Management Rate
EMRs are capable of measuring around disease management parameters provided the information is
entered in a place where it can be searched.
Example:
Dr. Brown wishes to measure how many of her active, paneled patients with diabetes have an HbA1c
result below 7% in the last year.
Generic equation:
# active, panelled patients with diabetes+ with an HBA1C result below 7% in the last year x 100 = rate (%)
# active, panelled patients* with diabetes+
+

Patients identified as having diabetes when Diabetes is listed as an active problem in their Problem List

Care Planning
For clinics participating in PaCT, progress on identification and care plans completed may wish to collect
supporting measures. In this case the clinic may wish to measure how many patients have been identified
as having a complex health needs and, of those patients, how many were offered care plans with the new
process on a monthly basis. To do this the two monthly searches would be:
1. number of patients with complex health needs
2. number of patients with complex health needs with a care planning template
An improvement graph may look like this:
160
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60
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40
20
0
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Appendix A: Care Planning Template (with
prompts)
Download the most up to date template at:
http://www.topalbertadoctors.org/pact/pactcommunicationtoolkit/
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Appendix B: Sample Common Problem Lists/
Diagnostic Codes Lists for Primary Care for
standardized EMR data capture
These examples were from real clinics or PCNs
Example 1: TOP 32 CODES

SYSTEM

CODE

DIAGNOSIS

Endocrine

250
244
279
272
340
345
346
434
780.5
723
715
714
729
724
781
311
300.0
290
496
493
428
427
414
401
443
564
585
628
626
627
305.1
303

Diabetes
Thyroid (hypo)
Obesity
Lipids
M.S
Epilepsy
Migraines
Stroke
Sleep Disturbance
Cervical Disorder
OsteoArthritis
Other Inflammatory Polyarthropathy (Rheumatoid Arthritis)
Fibromyalgia
Back
Chronic Pain
Depression
Anxiety
Dementia
COPD
Asthma
Health Failure
Arrhythmia
Coronary Artery
Hypertension
Peripheral Vascular Disease
Functional GI Disorders
Chronic Renal Failure
Infertility
Menstrual Disorders
Menopausal Disorders
Smoking Dependency Syndrome
Alcohol Dependency Syndrome

Neurological

MSK

Psychological

Respiratory
CVS

GI
Renal
OB/GYN
ADDICTIONS

Created by the Red Deer PCN
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Example 2:

Sample Standardized Problem List (simplified without using ICD9 codes)
Addiction
ADHD
Alcoholism
Alzheimer’s Disease
Amputation
Anemia
Aneurysm
Angina
Anxiety
Asthma
Autism
Bell's Palsy
Bipolar Disorder
Blindness
Borderline Personality Disorder
Cancer
Celiac Disease
Cerebral Palsy
Chronic Pain
Cluster B Personality Disorder
COPD
Crohn's Disease
Dementia

Depression
Diabetes
Down's Syndrome
Eating Disorder
Epilepsy
Erectile Dysfunction
GERD
Glucose Intolerance
Gluten Intolerance
Grave's Disease
Hemophilia
Hepatitis
Hepatitis B
Hepatitis C
High Blood Pressure
High Cholesterol
HIV
HPV
Insomnia
Learning Difficulties
Learning Disability
Major Depressive Disorder
Mood Disorder

Obesity
Obstructive Sleep Apnea
OCD
ODD
Other
Panic Disorder
Paralyzed
Paraplegia
Parkinson's Disease
Personality Disorder
Phobia
PMDD
PMS
Psychosis
PTSD
Reactive Attachment Disorder
Schizoaffective
Schizophrenia
Seasonal Affective Disorder
Seizure Disorder
Sensory Processing Disorder
Tourette Syndrome
Created by Edmonton Oliver PCN
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Appendix C: Lists of scanned document index
words/keywords
Wolf has 3 possible keyword fields. Clinics with a standardized list of keywords will reduce Rule
mismatches and improve accuracy of Searches. This is an example used by many clinics in the Calgary
Area. Tips for a good keyword list:
1. Discuss as a team and create a clinic and region specific list. If the clinic has years of documents
linked already, focus on keywords that affect Rules and Searches such as:


Mammogram



Colonoscopy



Netcare Paps

2. Keep the list simple and straightforward. Avoid complexity.
3. Post the list at stations where staff are linking documents
4. Assign one staff member as the “keeper of the list”. This person is responsible for adding or
removing items. Staff can also go to this person to ask questions if they don’t what keyword to
use.
5. Ensure all new staff members are trained using the list and are aware of the importance of
keywords for Rules and Searches.
6. Always be sure to link any result by the date the test was done, not the date the result was
received.
Keyword 1

Keyword 2

24HR BP

Location

Audiology

specialist

Blue Cross

-Special Authorization
-Letter

Keyword 3

Bone Density
Colonoscopy

Specialist

Complex Care Plan
(in house)
Complex Care Plan
(by another provider)
Consult Letter

Netcare

Name of Provider

Specialty (ie. Cardiology,
ENT, Orthopedics)
Location

Specialist

Discharge Summary
Driver’s Medical
ECG

Specialist Name or CLS

Echocardiogram

Specialist

Endoscopy

Specialist
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Holter Monitor

Location or Specialist

Insurance Forms

Name of Agency
(Keyfacts, Manulife)
Name of Lawyer

Legal forms/ Letter
Mammogram

Misc Lab Result

Body location (ie. L Breast, R
Breast, Bilateral)
Physician name (you are
requesting from)
Physician name (you
received from)
Name of test

Miscellaneous

Be specific about what this is.

MRI

Location
(ie. PLC, SHC)

Medical Records Request
Medical records Transfer

Received from: CLS,
Netcare, Prov lab
Body Location
(Ie. Head, L Knee) Indicate
left, right or bilateral

Netcare Pap
Newborn Record

Location/ Hospital

Parking Placard
Pathology Report

CLS/Hospital

Prenatal report

Location
(ie. PLC, FMC)
# of weeks/ dating

Prenatal U/S
Radiology

Tissue item
(Breast, Skin)
Delivery Date

Body location
(ie. L Spine, Abdomen)
Indicate left, right or bilateral

RX

Name of test
(ie. Xray, Ultrasound,
Prenatal Ultrasound)
Faxed / Received

Surgical Report

Location/Hospital

Tom Baker

Specialist

Type of Surgery
(ie. Appendectomy)
Specialty

WCB Report

Location Index (from the Calgary Area)
Location
Foothills Hospital
Peter Lougheed Hospital
Rockyview Hospital
South Heath Campus
Tom Baker Cancer Centre

Acronym
FMC
PLC
RVH
SHC
TBCC
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Provincial Laboratory
Calgary Lab Services
Airdrie Urgent Care

Prov Lab
CLS
AUCC

Appendix D: Calculating Panel and Clinic
Confirmation Rates Worksheet

Created by Highlands PCN

94

